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Part 1 How To Activate MyPBX
Client Addon
1 Activate MyPBX Client Addon

To activate client Addon, you should provide your MyPBX LAN MAC address. You can find it
on the motherboard or the enclosure of MyPBX.
Here is a screenshot of a MAC address:

(Figure 1-1)

Notes:
1. Client addon is available on MyPBX Enterprise/U100/U200/U300/U5XX series only
now.
2. LAN MAC is the key to get license.
Please contact the reseller/dealer from whom you got the MyPBX to purchase activation
license.

Below is the steps to activate the Client addon:
Step 1. Click “Addons” to switch to the Client addon activation page.

0
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Note: For usage of the following addon, please purchase activation code from your equipment provider.

Call Recording (Non-installed)

Call Recording enables all your inbound and outbound phone calls to be recorded. The system would detect all call conversations and record them m Install
automatically. The call recordings would be saved in the folder you specify and stored in a USB device

MyPBX Glient (Non-instalied)

MyPEX Client is an application coordinated with MyPEX that connects your PG and IP phones. With MyPBX Client, you can perform various aperations ) Instal
g including check extension status, manage contacts, voicemails, and COR of extension, realize click-to-call and call popup, send instant messages between
extensions, initiate a conference call, and create a call task, etc. Trial

Billing System (Non-installed)
Billing System can charge and recharge extensions and conduct data analysis. Both prepaid and postpaid are supported. Rate can be set according to
extensions. time pariods, call duration. prefix number and number length. Real-time recharging history. call logs. and statistic are recorded () Install
'WARNING: If Billing System is enabled, DISA and Callback functions would be disabled

(Figure 1-2)
Step 2. Click “Install” and enter the activation code you purchased, then click “Active”.

Install MyPBX Client

MAC: f4b543060134
Client Number: 30

Active Code: REYETR-CEFSF8D2D24F4FAQAQCIC16666FT1F12E

o Active | 3£ Cancel

(Figure 1-3)
Step 3. After you click “Active”, MyPBX will pop up a reboot tag. Click “Reboot now”, the
activation will take effect permanently after the MyPBX reboots.

Notes:

1. Activation is permanent in MyPBX even if you make a factory reset on MyPBX. If you
want to change the number of client, you should enter the activation code again and
confirm the number of client.

2. By default, MyPBX can support 2 clients even if you don’t activate it.

3. When you purchase activation code, you can ask for another developer, which is
“yea” by default.

4. You cann’t install the activation code on another MyPBX.

2 MyPBX Client Addon Settings

You can disable/enable/update the addon after it is activated successfully.

0
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MyPBX Client (Enabled)

- MyPEX Client is an application coerdinated with MyPBX that connects your PC and IP phones. With MyPEX Client, you can perform various operations + Update
& including check extension status, manage contacts, voicemails, and CDR of extension, realize click-to-call and call popup, send instant messages between
extensions, initiate a conference call, and create a call task, etc. ® Disable
(Figure 2-1)

Disable MyPBX Client addon

You can click “Disable” to disable MyPBX client addon temporarily.
Click “Disable”, MyPBX will pop up the window below, and then click “OK” to disable it.

4

(Figure 2-2)
Enable MyPBX Client addon

If you have disabled MyPBX client addon, you can enable it again by clicking “Enable”.

MyPBX Client (Disabled)

MyPBX Client is an application coordinated with MyPBX that connects your PC and IP phones. With MyPBX Client, you can perform various operations + Update
& including check extension status, manage contacts, voicemails, and CDR of extension, realize click-to-call and call popup, send instant messages between

extensions, initiate a conference call, and create a call task, etc. @ Enable

(Figure 2-3)
Update MyPBX client addon license

If you want to change the number of client which MyPBX supports, click “Update” and enter
the activation code and client number to active it again.

MyPBX Client (Enabled)
- MyPBX Client is an application cocrdinated with MyPBX that connects your PC and IP phones. With MyPEX Client, you can perform various operations + Update
& including check extension status, manage contacts, voicemails, and CDR of extension, realize click-to-call and call popup, send instant messages between

extensions, initiate a conference call, and create a call task, etc. ® Disable

(Figure 2-4)

Install MyPBX Client X

MAC: f4b543060134
Client Number: &0

Active Code: REYETR-CEFSF8D2D24F4FAQAQCIC16666FT1F12E

o Active | 3£ Cancel

(Figure 2-5)

0
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Part 2 How to use Client software

1 Introduction

MyPBX Client has clean and user-friendly interface as well as lovely icons. The simple and
human-based practices allow users to click to call out so easily that they don’t need to
remember any number; when users engaged themselves in thinking, no need to be
disturbed or annoyed by constant ringing tones, just give a “command” and MyPBX Client
will help you to politely decline incoming calls; when users are absent, no need to worry
about missing any important calls, MyPBX Client can help record voice messages.

Not only is MyPBX Client with call management functions that can easily manage the call
conference, voicemails and call recordings, but also a unified communication terminal that
can send internal instant messages.

0
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2 Install MyPBX Client

This section shows how to install MyPBX Client software on the PC.

1. Download the MyPBX from
http://www.yeastar.com/download/MyPBX-Client/MyPBXClientSetup1.0.0.4.exe

2. Double click the “MyPBX ClientSetup1.0.0.4.exe”, “Welcome to the MyPBX Client
Installation” screen will come up. Click “Next” to continue.

#1 Tnztalling HyPBE Client

Welcome to the MyPBX Client

Installation!
:;c__,f N This setup program will install MyPBX Client on your computer,
g Lfﬁ. Click Exit if vou do not want to install this application, Click Mext
T to continue the installation.
e

WARMING: This program is protected by international copyright
L law and
treaties,

Unauthorized reproduction or distribution of this program, or any
portion of it, may result in severe civil and criminal penalties and
will be prosecuted to the maximum extent of the law,

(Figure 2-1)

0
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3. Read through the software License Agreement, select “I agree with the above terms and
conditions”, and then click Next to continue. See Figure2-2.

=)

License Agreement
To proceed with the installation, you must accept this License
Agreerment, Please read it carefully.

Entering inta this Agreement: (MyPBX Client) ~

This End User License Agreement constitutes a valid and binding agreerment
between Teastar's MyPB® software (‘'Software') and vou, as a user, for the use
of the Software.

article 1 License and Restrictions

1.1 License. Subject to the terms of this Agreement, veastar hereby grants vou
a limited, personal or company, commercial, exclusive, sub licensable,
assignable, charge license to download, install and use the veastar Software on
‘four computer.,

[v]1 agree with the above terms and conditions

< Back Mext = ] [ Exit

(Figure 2-2)

4. Click Next after going over the provisions.

Readme
Please read the following information,

MyPBx Client; Easy-to-use call messenger at your fingertips -

MyPBEx Client is an easy-to-use application of MyPB¥ designed to provide fully
integrated unified communications for SMBs.

With MyPBx Client, the user is able to see the status or presence of the other
users, click to zall from the phonebook or Microsoft Qutlook; see missed,
inbound and outbound calls; create and manage conference calls; schedule call
tasks; check woicemails and recordings, to name just a few,

Tao top it off, MyPBX Client offers instant messaging (IM), email and SMS
functionality that gives users the power to quick contact people in either local or
remote locations; also it enables users to have sidebar conversations during
calls, or to bring several people into a chat session,

Cnce installed, there will be a shortcut of MyPBX client on the desktop. Double
click it, and then the user can manage their extension easily from desktop,

1
| < Back I Mext = Exit

0
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(Figure 2-3)

5. The Destination folder screen allows you to decide where to store MyPBX Client on your

computer. Click “Next” to continue.

43 Installing NMyPBE Client

Destination folder

Select a destination folder where MyPBEX Client will be
installed.

Setup will install files in the following folder.

Browse and select another folder.

Destination folder

If vou waould like ta install MyPBx Client into a different folder then click

Z:Program FileshreastarsMyPBRClient

Browse... |

< Back

Next =

Exit

(Figure 2-4)

6. A screen pops up to notify you that:
(1) Run Installed application
(2) Create Shortcut(s) on Desktop
(3) Start MyPBX Client when | start Windows
Enable the options as you wish, and then click ‘Next’.

0
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Z Installing NyPBE Client

Select from the following installation options.
Click Mext to begin the installation. Click Bacl if vou would like to change the
installation information,

Run Installed application
Create Shortcut{s) on Desktop
Start MyPBX Client when I start Windows

(Figure 2-5)
7. Enterinto the “Installing Files” page. The system begins the installation, which will take a

while.

42 Installing NyPBE Client

Installing Files
Copying MyPB¥ Client files to yvour computer,

To interrupt or pause the installation process, click Cancel.

Directory: O
File: MyPBX.exe

[------------------------ ]

MNext =

(Figure 2-6)
8. When the installation is complete, a screen will pop up to notify you that the software is
installed successfully. Click Finish.

g
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43 Installing NyPBY Client

MyPBX Client has been
successfully installed!

Click Finish to complete the installation,

(Figure 2-7)
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3 Log in MyPBX Client

After the installation, you can enjoy the powerful functions MyPBX Client offers.

Double-click shortcutm and launch MyPBX Client. Please enter your Ext. number and

password and then click “Sign In”, see Figure 3-1.

il Help Please pay attention when
you log in for the first
time:

Please click “Tools” on
menu->0ptions, and enter
the IP address of MyPBX
Server and Client Developer

Extension

g4l & on Figure 3-2. You can get

Passvord this IP and developer from
Admin.

[lsign me in when Client starts About Ext. and Password

[#]5tart Client when computer starts

Obtain the Extension and
Password from your system
Admin before you log in

[(sign in |
: MyPBX Client. The password
for extension is the voicemail
PIN. Check it on the extension
edit page on MyPBX.
(Figure 3-1)

g
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| Sysu:m Swystem

Fill in MyPBX IP
Server |P address: 192.168.5.101
Client Developer: yea

Fill in Developer "yea"

Sign me in when Client starts

[ Start Client when computer starts

| ok || cancel Apply

(Figure 3-2)
Note: On Sign in screen, you can also enable following settings:

Sig;n me in when Client starts

St:art Client when computer starts

4 Managing MyPBX Client

4.1 Extension Management

When sign in MyPBX, system opens a main screen—> Extension screen as Figure 4-1 shows.

0
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File View Contacts Tools Help

"[7] MyPBX - 6041 =S Lf‘

S Call Task
(pull-down)
Here you can edit your " \Calltask = 52 Conference You can create, show,
profile. J Eﬂﬁm“ Cortacts || History |\ Voicemail ” Hﬂmrding|
1 extensions online
"T| | Mame | Bt .no
_ ek Sl Conference

Open a conference
window with selected

Enter the ext. number

S 9
89
- I 4
S 9
89
S 9
89
S 9
S 9
S 9
a9

Click here you can show or

you want to call here, or

e

hide keyboard (Figure

choose a dialed number

through the pull-down

End call

Call button, call the
number entered in the (Figure 4-1)

0
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[ [7) mypex - 6041 (==] = ]
File View Contacts Tools Help
o
6041(Online) sk
" \Calltask v 82, Confersnce
J Edms” Contacts ” Histnry” Voicemail || Hﬂmrding|

1 extensions online
© | Name | Bdno | Mobile  *

8 P sk 6041

0y Rl el
o, 4y Prnce 6028
& G Myon 6023 =
& 3 Michael 6026
8 ey 5024
S .Z? Jason 6020
oy dame 6025 | i
3 .Z? Hamy G021
o, 4y Catherine 6022
o 4y Athur 6027
8 P o soss
& iy 6048 6048 -
4 | i F

:

El
i
EE
i

— L2 2
& © ] =Ts o=
h - 7=~
(Figure 4-2)

Indicates client user is offline

Indicates client user is online

Indicates extension is unregistered or unavailable
Indicates extension is idle

Indicates extension is ringing

O QU ¢ 0 w

Indicates extension is busy
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4.2 Contacts Management

After signed in MyPBX Client, you can see “Contacts” tag as Figure 4-3 shows. Here, you can add,
edit, delete, send, import and export your private contacts.

T P
File View Contactz Tools Help
:j -
8041 Dnline]
Call task v 82 Conference
| Extensions ” Contacts ” History ” Yolcema1l ” Becording
Hame Office Mobile
‘ﬂ Manzo 2B39952 13015932666
‘ﬂ Banana S9T2E95 130748585175
‘ﬂ Haw 222PE15 13400823023
‘ﬂ Orange 2950777 13599902652
‘ﬂ Lemon S1BTOET 13808914903
‘ﬂ Cherry 05TTE2S515009 13TSTTTSETS
I ‘ﬂ hpple STES0EE 13808095554
‘ﬂ FPear BOZ21323 15959373125
E.I Eric 0Z216B363206 18802101933
[
< )
~
| Ll
a5 8
“oe
(Figure 4-3)

4.2.1 Contacts Group Management

You can see contacts in group through “View” > “Show Contacts Group” (see Figure 4-4).

0
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M EyPEE — 6041

File BSRYE Contacts Tools Help

v Show dial panel

S

GaEAN] ¥ Show contacts zroup

Contact
groups list

;_._i_Call tazk v 8@ Conference

— < Extensions || Contacts ” ]'[istl:-r}'” Yoicema1l ” Recording

% Add Group ?(:Ilelete Group |

Hame Office Mobile Delete
C “ Toni ST02543 15253213512 selected
olleagues [
Friends "!5‘ Fhilip SBG34022 1342522352
Ungrouped "!5‘ TonyZhang To159551 1355902124
"!5‘ SinTom ST0Z560 15562315954
:7 "!5‘ Kewin SE340635 19922536232
‘5, Jesscica T1S5EZ352 159524135652
"!5‘ catherine 25166545 15560255416
"!5‘ Hogrony B4B25EG 15426527524
"!5‘ Ben 15643663 15244305235
£

51--_ g [

“3)

(Figure 4-4)

4.2.2 Add New Contact

1. You can add new contact through Menu—>Add New Contact (Figure 4-5a) or click the mouse to

op

en the adding screen as Figure 4-5b shows.

g
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M XyPBX - D41

B

M EyPBE — 6041

File View [ Teols Help File Vier Contacts Tools Help
dd .
8- 8-
Edit contact’ s profile
B0AL Quling [ 6041 (Online)
Tl ta g enat [Call task v M Conference
Extensions ording Extensions|| Contacts || History | Voicenail|| Recordin
s R \ [Gontasts][ Fostors| [ecoraiee]
Liadd 6ro fiAdd Group X Delete Group
Upload locel data to server B X
Dowrload clisnt deta fice Mobile Fane Dffice Mabile
Colleagues T 2543 15253213512 Cellesmes 5 Tem
] ili a L.
Friends & Thilip Shas0ze { e Friends & Fhilip Bdit contact’s profile... o000l
Vngrouped & TonyThang 7515551 1355902124 Ungrouped & Tonylheng Wowe to Group B5a02124
& siaTon 5702580 15862319954 & sinTon Start cell.. BB2315954
& evin 52340835 15822636232 & FKevin Delete contact B2835232
& Tesscica 71852352 15952413652 & Jesseica 52413652
&, ratherine 25186845 15860285416 & catherine Refresh BB0ZESA1E
& Tagony 5455528 15426527524 & Fpony 5455528 15426527524
& B 15643863 15244565265 & Ben 15643863 15244585285
] 2 ] »
5702643 ] 5702543 x|
- ‘.-l @ I_‘ - ‘.-l 2 I_\
poo |vEe ooo a8 e
LR @ L
= 0. |/ o

(Figure 4-5a)

(Figure 4-5b)

2. Please edit contact’s profile on the following screen; the details include name, office phone,

and company name and so on. (Figure 4-6)
M Add new contact

g Contact™ = profile

x

Name (Green_tea |
Group Unegrouped vl
Office 81284513 | Memo

Mobile 13123525455 |

Home | |

Company (Teastar |
Title | | Fax | |
E-mail ‘tea@yeastar. com | SKYPE | support.yeastar |
Postcode | wsw | |
Weh v, yeastar. com |
Address | |

dpply || 0K | | cancel |
(Figure 4-6)
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3. Click “Ok” or “Apply” to add new contact.

Note: On call history, right click on the item and from the menu you can “Save Number” to your

contacts.

4.2.3 Edit Contact’s Profile

1. Click on the chosen contact, and open the “Contact” menu—> “Edit contact’s profile” as Figure

4-7a shows or right click to open the menu as Figure 4-7b shows.

File View JHO&E

Sv

6041 (Inline

Delete contact..

M XyPBE - 6041
File V¥iew Contactz Tools Help

dv

6041 (Inline)

Bl b Lt contect. “ICall task B Conference
Extensions b Extensions | Contacts || History|[ ¥oi cenail || Recording
J: Bxport contact.. | H H ” H |
[ 84 Gror [iatd Grop K Delete Gromp
Upload Locsl dsts to server
Downlead client dats fice Mobile BERE
Colleagues | 3 02543 15253213512 Colleagues & Toni
Friends & Thilip SEA40E2 1352352 Friends & Eilip
Ungreuped # Tomylhang 7515551 1355902124 Tngrouped & TonyZhang ::‘:t‘:ﬁ“" 55U02124
& sislen ST02560 15867315954 & sinlon 5352315954
2 Tevin 52340635 153228368232 & Hevin Telete ontact... Sazos3EzI2
& Tessciea 71552352 15057413652 & Jesseies 5957413652
& eatherine 25186645 156E02E5416 &, cstherine | Refresh 580285416
& Fayony B4B5EEE 15476527524 & toyory 6465529 15426527524
& Ba 15643663 15244565265 & Ben 15643663 15244565265
A ? 3 £
5702543 x| [57028e3 x]
Pt rae ’_ res
o if 458 oog 458
(9 res ‘9 rew
0 e “- 0@ J

(Figure 4-7a)

(Figure 4-7b)

2. Here you can modify the contact’s information. See Figure 4-8.

0
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M Edit contact

Group
Office
Mobile
Home
Company
Title
E-mail
Poztcode

Weh

bddrezz

X
profile
Philip |
| Mngrouped L‘ill
|B6B4022 | Meno
1342622352 |

| SEYPE |

| MSH |

| ox

] [ Cancel

(Figure 4-8)

3. Click “OK” to save the changes.

4.2.4 Delete Contact

1. You can delete the chosen contact through menu “Contacts”> “Delete contact” or click on

right mouse to delete directly.

7'.‘ Yeastar
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M NyPEX - 6041

M XyPBY - 6041
File
8-

E041 (Online

Tools Help File View Contacts Teols Help

Sv

o BO41(nline) s

cts

LT Con

Add new contact. ..

n 1]
CACAI tas rod contet [ Call task v 8 Conference
Extensions ording Extensions || Contacts || History || Voicemail || Becordimn
|EEET —— [ [Fomtactz[Hstory | [recerding]
1444 Gro {LAdd Group Delete Group
Upload Local data to server [ x
Download elient data fice Mobile | Hame | DEfice Mobile
Colleagues =T 5702543 15253213512 Collesgues & Toni 5702543 15253213512
Priends 2, Fhilip 5684022 1342522358 Friends 2, Fhilip Eean 1342522352
o . Add new contact
Ingrouped & Tonylhang 7515551 1355302124 ngr ouped & Towrhang | g s presils 1355907124
& sixlon 5702560 15982315054 & SixTon Move to Group 15062315954
& Kevin 52340635 15022835232 &, Tevin Start call. . 15922839232
& Tessvica 71552352 15952413852 & Tesscica 15952413652
£ catherine 25166645 15380285418 & estherine | fend S5 15330285416
& Hoyony 5465528 15426527524 & Tayony Refrech 15426527524
& EBen 15843663 1524456255 & B 15R43663 15244585285
L] 2] -] -]
5684022 x| (664022 ]
[ [waa
11,4 \ poo 488
| ] ree
@ r y S
(Figure 4-9a) (Figure 4-9b)

2. Click “Yes” to delete this contact as Figure 4-10 shows.

|

Areyou sure to delete the selected contact?

e ) w

(Figure 4-10)

4.2.5 Import Contact

1. You can import contacts from menu “Contacts”--> “Import Contact”.
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M EyPBE — 6041 M(i=1E3
File Wiew EHGAREVIEN Tools Help
5 - #dd new contact. ..
Edit contact’ = profile. ..
5041 Online Delete contact. .. ’
'__-_'r_Call tas Import contact. ..
| Extenszions ording
Export contact. ..
LA Add Gro
— Tpload local data to server
All Download client data fice Mobile
Colleagues 3 Fhilip ERE402Z 1342527352
Friends ‘5‘ TonyZhang TE15651 1355902124
‘5‘ SinTom STOZER0 15852315954
‘5‘ Kewin 52340835 15922838232
‘ﬂ,‘ Jesscica T155Z352 1595241 3652
‘5‘ catherine ZE1BEE4S 15880285416
‘5‘ Hrgromy B4BEEZE 1542B5ZTE24
‘5‘ Een 15643863 15Z2445B5285
T >
F684022 foel|
— |
i ?,. i 488
raw
= 0 & |

(Figure 4-11)

2. Select the file (.csv) you want to import and click “Open” button (figure 4-12).
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open 2/ x|

Lok in: I@ EO03 j € 3 i o

File name: IEantacts.csv Open

Files af type: |["_.:w] j Cancel |

[~ Dpen as read-only

P

(Figure 4-12)
3. Double click the item to select corresponding address, see Figure 4-13.

M Nap the fields you wish to import

Text field=s bddrezs book fields
“DisplayName” Last Name
“OfficeNumber” Office Phone v
“Mobillumber”
“Gthefmum“r Family Name
‘Line Last Name
(Ring”
Group Mobile Phone

Home Phone

Group

Job Title

Company

Fax

MSN

Skype
&) Double click item to =zele|Postcode

Address

Email

Web |

(Figure 4-13)
4. Click “OK” to finish this step.

4.2.6 Export Contacts

1. You can export contacts to save on computer as well. See Figure 4-14.
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File Wiew ICuntacls Tools  Help

Add new contact...

Edit contact's profile...
Delete contact...

Import contact...

Export contact...

Upload local data to server

m@ Download client data -

6028
6023
6026
6024
6020
6025
6021
6022
6027
6049
6043

(Figure 4-14)

6o Go Go Go Co Go Gu o Co Co Co
VAR AR R AR AR

£

:

2. Select the routing that you want to save, and then click “Save” to finish as Figure 4-15 shows.
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saveas 21 x|
Savejn:lE}EElElEi j € 5 e

File name: | Contacts Save I
Save as upe: I[“.u:sv] j Cancel |

(Figure 4-15)

4.2.7 Upload local data to server

You can upload local data to MyPBX server to save it. See Figure 4-16.
Note: If you have uploaded local data to MyPBX server and you want to upload it again, your
data on MyPBX server will be covered with new data.
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M EyPBE — 6041 M=1E3

File View BMSASVIEN Toolz Help

Add new contact. ..
.& -

G041 (Dnline

._.;:.-C*all = Import contact. ..
J@ Export contact. .. m‘
L5 Add Grg
Dawnload client data fice Mobile
Colleagues ﬂ Tam ST02543 15253213512
Friends ‘5‘ Fhilip SB54022 1342522352
Ungrouped ‘5‘ TonyZhang T515551 1355902124
‘5‘ SinTom 5T02560 1585235315954
‘5‘ Eewvin 52340835 15922538232
‘5‘ Jesscica T1552352 15952413652
‘5‘ catherine Z51BEB45 15580255416
‘5‘ Hngrony E4G5525 15426527524
‘5‘ Een 15643663 15244565255
< >

=]

T
o m R
- e

(Figure 4-16)

4.2.8 Download client data

Since you have uploaded local data to MyPBX server, the next time you change a PC to log in
MyPBX Client, you can download client data from MyPBX server using the same username. The
operation is also used in case of losing data.

Note: If you download client data, the local data on PC will be covered.
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M EyPBX - 6041 r

=ES

File View BMIAENEEN Toolz Help

Add new contact. ..

G041 (Online

. Call tas Import contact. ..

Extensions ording
Export contact...

[ Add Gro

Download client data fice Mobile

Colleagues P 02543 152532135512

Friends ‘5‘ Fhilip SES4022 1342522352

Ungrouped ‘5‘ TonyZhang 7515551 1355902124
‘5‘ SinTom STOZSE0 15552315954
‘5‘ Kewin SZ340635 15922535232
‘5‘ Jes=cica 71552352 158524135652
‘5‘ catherine 25186645 155802585416
‘5‘ Hngrongy B4B5525 15426527524
‘5‘ Ben 15643665 152445685285

|

o -

Li-il- II |

(Figure 4-17)

4.3 Call History

After signed in MyPBX Client, click “History” tag to enter the call log screen (Figure 4-18). Here
you can see all the calls that have you made or answered. Call information including callee name,
telephone number, call time, and duration will be available on the list.
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Right click on the selected
item, you can generate a
call, save number or
delete this item from the

M EyPEX — 6041

File W¥iew Contacts Tools Help

‘37

6041 (Online)

;_-i.l:all tazk ¥ 82 Conference
| Extensions ” Contacts ” Historfn".l'oicemail || Recording|

Humber Hame Call time
0 5T025430 Toni 2013-01-12 10:42:40
0 BO13 ~n13-01-12 10:29:18

I/ 3 - 3-01-12 10:25:18
| | Save number. ..
_ 986584857956 3-01-12 09:18:53

Remowe from hiztories. ..

Remowe all. ..

Refresh

|A

Dhratioen

00:00:00
00:00:52
00:00:00
00:00:06

You can arrange items in
sequence according to
call types, number,
name, call time, and

Ainiratinn

L

(Figure 4-18)

0 Stands for incoming call
&) Stands for outgoing call
&> Stands for missed call

4.4 Voicemail Management

After signed in MyPBX Client, click “Voicemail” tag to enter the voicemail listing screen (Figure

4-19). Here you can see all the caller number, name, call time, and duration.
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Play

Play selected voicemail.
When playing, click the
button to pause it.

M ExPEE — 6041

File V¥iew Contactz Tools Help

dv

BO41 [Online)

'__;:P_Call task * 5% Conference
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COX

| Extenzions || Contacts ” ]'[istu:-r}'” Voicemail ” Becording

WaFlasy L

Inbox Humber
01d [~] 8013
Worlk [=] B081
Family
Friend=

45

Hame

Jazon

Tane

Call
2013-

2013-

B R =

Stop Button
Click this button to stop
the playing.

[=] Unread message

i~y Read message

(Figure 4-19)

Inbox: the folder where new message is stored

Old: after reading the message, the message will be automatically moved to this folder

Work: after reading the message, the message can be moved to this folder

Family: after reading the message, the message can be moved to this folder

Friend: after reading the message, the message can be moved to this folder

Note: You can call the number, save or delete the voicemail through right-clicking, but you can’t

directly move the message to other folders.
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4.5 Recording Management

After signed in MyPBX Client, click the “Reading” tag to enter the calls reading list screen (Figure
4-20). Here you can see all the status, call time, and duration.

7] MyPBX - 6024 C="r=n X

| ——

File View Contacts Tools Help
6024(Cnline) s
© Calltask v 52, Confersnce

| Bxtensions || Contacts ” Histur:.r” Waicemail “ Recording || Call |

WaPlay by Stop Button
Play | MNumber | Name | Call time Click this button to stop
Play selected recording. Q 6072 Sandy 2013-05-11 the recording of the
When playing, click the 0 6072 Sandy 301305411
button to pause it. Q 690 201
L L 3
|
.l 28 |
4 5 @&
| Pew

(Figure 4-20)

Note: You can call the number, save or delete the recording through right-clicking.
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4.6 Call Status Management

1. When there’s an incoming call, a prompt screen will show the caller’s detailed information.

M EyPBEE — 6041
File View Contacts Toels Help

Sv

6041 (Dnline)

Call task v R
| Extensions ” Contacts || History” Volcemail ” Recording” Call |

If you have already .

edited the caller or \\:." 6013

extension’s profile, > Tob Title:

it will display the Company:

r/ Weh:
Click here to forward
the incoming other
extension or outside
Z o | numbers
Ring. ..

Click this

@ button to
|

(Figure 4-21)

2. When there’s an outgoing call, a prompt window will show the callee’s detailed information.
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M EyFEX — 6041

'37

6041 [Online)

File WView Contactz Tools Help

. Call task v S

Extensions ” Contacts || ]'[ist-:nr}'” Volecamall || Recnrding” Call |

t{* Jason
6013
Job Title:

Comparsy:
feb:

!5""""_ E

-k
|-

(Figure 4-22)

3. During a call, it prompts as Figure 4-23 shows.
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File View Contacts Teools Help
3'
E041 (Orline)

Call task v @

Ixtensions” Contacts ” History” Volcemail ” Recording” Call |

) Jason
i“‘“{ 6013
HOId on Job T;.le:
Click this
button, it will
hold on the
- | Record
Button
Call Forward Click this
Click this button to
button to ;
S Q@
forward the f
00:00:09
call to other Time
extension/ . “t“ Show call
% ; E E duration

(Figure 4-23)

4.7 Personal Profile

For the convenient communication with your colleagues and friends, MyPBX Client provides
personal information management, so that you can update profile at any time.

After signed in MyPBX Client, click “File” = “Edit profile” to open personal information screen.
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MyPEX - 6041
File | View Contacts Tools Help
Edit profile...
Change password... ';3,:
Sign out
T ExEnsions onine :
© Name Bxtno Mobile *
3 :.}"‘ Jack 6041
oo e 029
o, 4y Prince 6028
& 7 Myon 6023 =
o 7 Michael 6026
o deny 6024
5 Oy Jason 6020
o ) dane 6025 L4
o 3 Hamy G021
o, 4y Catherne 6022
o o7 Athur 8027
S P 6 6049
& o7 68 6048 -
1 1] r

5
=

Bow s
o®n R
- e

(Figure 4-24)

M Edit your profile

WName | catherine |

Mobile | 16880270231 |

| ok || cancel

(Figure 4-25)
Here you are allowed to change name, mobile phone number.
You can change password through “File”=> “Change Password” setting as Figure 4-28 shows.
Open the password screen as Figure 4-26 shows and enter both the old and new password, after
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which a pop-up will prompt you as Figure 4-27 shows.

M Change password |E|

01d pazsword

|**** |

New pazsword

|**** |

Fepeat new pazsword

|****| |

| ok || cancel |

(Figure 4-26)

Medify password successfully, it will take affect log in again.

(Figure 4-27)
4.8 Refresh

You can right click the mouse and click “Refresh” on menu as Figure 4-28 shows to gain the latest

data. For example, the current page shows all extensions, MyPBX Client will get the extension
information again after clicking “Refresh”.
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J Entumms” Currtac:ts” Histury” Voicemail ” Hﬂmrdiﬂgl

1 extensions online
© Name

a @ Jack

5 7 Rela

o

~=

Ge Go o Go Co Go Go Go Co Co |
YAA AL LA LEEE]

| Bd no
6041

Start chat...
Send 5M5..
Start call...

Pick up call

Refresh

Chat history...

£

5

0
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(Figure 4-28)
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You can set up whether or not to show dial panel on menu “View”—> “Show dial panel”. (Figure

4-29)

M EyPBE — 6041 (=13

File View Contacts Tools Help
8~
6041 [Online)

Call task v M Conference

J Extensions || Contacts || History” Voicemail || Recording

2 extenszions online

Hame Ext.no

oy BhEERR 8040
5 _'3" catherine BO41
o :/‘ 305 305
8 p 304

Ly 03 303
o 302
o :/‘ 301 301
& :/‘ 300 300

(Ead

Mo

15§

M EyPBX — 6041

Contarts Tools  Help
BO41 0 Show contactsz group
©'Call task = 2 Conference
J Extensions” Contacts || History” Voicemail || Recording
2 extensions online
Hame Ext. o "o
o REiER 8040
5 Q“ catherine BO41 15¢
S a5
Ly m 304
L oy 303 303
Ly 302 a0z
ooy oam 301
o oy 300 300
<
A0dn

[so0e E |»

0
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(Figure 4-29)
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4.10 Change Language

”

MyPBX Client has multiple language versions. You can change the Client language through “Tools
- “Change Language”. (See Figure 4-30)

File View Contacts ITouIs Help

Change Language BRI (Chinese Simplified)
SEARAT (Chinese Traditional)
English

Options...

\Calltask v 52 Confersnce

J Edmstons“ Contacts ” Histnrf” Voicemail ” Hecurding|
1 estensions online
C Name Btrno | Mobie  ~

te
¢

&9
&9
89
&9
S 9
89
S 9
89
S 9
&9
S 9
S 9

A

H

(Figure 4-30)
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4.11 Call Forwarding

You can forward incoming calls at any time. Configure it through “Tools” = “Options” (Figure

4-31).

MyPEX - Options e

System

Call forward

Call forward

Feature Codes

Speed Dials [T Aways ~
@ Voice Mail
Calls Mo Answer Transfer to:
() Number
When Busy
| oK || Ccancel Apply

(Figure 4-31)

» Always: Always forward calls

+ No answer: If no answer calls will be forwarded to

= When Busy: forward calls when you are busy in a call

. Transfer

to:

the incoming call

will be transferred to

designated “Number” according to your own demands.

0
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Note: If call forwarding is set to external line number, please input the prefix before number.
For example, “9” stands for PSTN trunk routing, “81” stands for SIP trunk routing, and “7”
stands for Skype trunk.

4.12 Feature Codes

You can check the shortcut operation of call on hold, pick up calls and so on. Click on
menu “Tools”> “Options”—> “Feature Codes” (Figure 4-32a) or click on “Feature codes” on the
interface directly as Figure 4-32b shows.

[ wyrex oo, D s
File View Contacts Tools Help
s = Change Language 3 s -
6041(Onine) [options.. | || [eeteonine

i
[ \Calltask » 2 Corference [Calltask v 52 Conference

J Extensons” Contacts” History” Voicemail” Recording| JE:da'ls'ons” Ccnlads” Hiﬁ"f)’” VUiCE"'IE'“” HBCdeiﬂQ|
1 extensions online 1 extensions online
|| Name | Bdno | Moblle |~ || Name | Bano
& P Jack 5041 8P
8 P R a0 82
o Iy Pince 6028 8 9
5P e o2 Ale=
o O Michael 6026 a8 9
8P s ouzs 82
o P Jason 6020 8 9
o G dane 6025 L a8 9
o 3 Hamy 6021 8 D
o Iy Catherne 6022 8 9
o Oy Athur 6027 8 9
8 9 s 82
8 o e e IreE
1 [ 3 <
|6{}28 @]I 6028

(Figure 4-32a) (Figure 4-32b)
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o
e orse: ==
sytem Feawre Codes

Call forward General
One Touch Record ¥
_ Extension for Checking Veicemail B
speed Dials Viicemail Main Menu 02 #
Calls Attended Transfer ]
Blind Transfer 03

Extension Pickup ¥
Irtercom ¥
Call Parking O

Mormal Spy 50 B
Whisper Spy “31 [#
Barge Spy 52

Call Forwarding Preferences
Reset to Defaults *70 ]

Enable Forward Al Calls @
Disable Forward All Calls E

Enable Forward When Busy 72
Disable Forward When Busy ]
Enable Forward Mo Answer 73 |

Disable Forward Mo Answer
Forward to Mumber B
Forward to Vaicemail B

Enable Do Mot Disturb “75 E

Disable Do Not Disturb

(Figure 4-33)

4.13 Speed-dial

On menu “Tools”> “Options”—> “Speed Dial”, you can check the speed-dial number on Figure
4-34. For example, if you want to call number 918859206002, then just dial 123 directly.
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Sysem speedDials
Call forward CPrefic  Substite
Feature Codes & 123 913359206002
SR | & = sewer
Callz
Lok J[ Cameel || st
(Figure 4-34)
4.14 Calls
Through the menu “Tools”-> “Options”-> “Calls” to manage the calls.
..'Y
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System Calls

Call forward

Pop-up window when someone call in
Feature Codes

Speed Dials Dial Pattem 9.
Calls
Automatically answer dialing out
Phone Type Yealink -
Asstra

Fanwil
GRAMDSTREAM

F‘uﬁum

[ ok || cancel || Apply

(Figure 4-35)

» Pop-up windows when someone call in: Client will bomb the caller’s ID for an incoming call.
« Dial Pattern

= Automatically answer dialing out: When you enable this option and click a number to dial out,
your IP phone will answer it first.

Note: You should select your IP phone type correctly. For example, if you are using Yealink IP
phone, please select Yealink.
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4.15 Help

File View Contacts Tools | Help

About MyPBX...

~ |Calltask v 52, Confersnce
J Edamnns“ Currtacts” I-ﬁstury” Vaicemail ” Hﬂmrdlng|
2 extengions online

© MName

6o Go Go Go Go Go 6o Go Go Go Go G B
A A AR AR AERERLR)"

£

13812345678

(Figure 4-36)
4.15.1 About MyPBX Client

You can know the MyPBX Client version number and copyright through menu “Help” = “About
MyPBX Client”. See Figure 4-37.
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M About NyPEX

MyPBX

NxFPEX Client Verzion 1.0.0.4

Copyright (C):
2011-2012 YEASTAR TECHNOLOGY

http:/ Fwnr, veast ar. com

(Figure 4-37)

4.16 Sign out & Exit

You can exit from MyPBX Client on menu “File”—> “Exit” or you can click on MyPBX icon on right
tray and click “Exit” to exit as Figure 4-38 shows.

Open MyPEX

(Figure 4-38)
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5.1 Dialing Call
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Press a key to dial out easily on MyPBX Client that simple the dialing procedure and save time.

Just move the mouse on the telephone and click it to dial out.

5.1.1 Call Internal Extension Number

You can call an extension number through three ways:

(1) Double click the selected Ext. number to call out

(2) Enter the Ext. number on the input box below and click “Call” button or “Enter” to call

out

(3) Click the Ext. number on the panel and then click “Call” or “Enter” to call out

[] MyPBX - 6041

File View Contacts Tools
3 -

6041{0Onling)

[ \Calltask = %2, Conference

Help

J BExtensions || Contacts ” Histor'_.'” Voicemail || F{ecordingl

1 extensions online

Start chat...
Send 5M5...
Start call...

Pick up call

Chat history...

\_| | Mame | B no
3 6041
b 4
9
g
b 4
9
F
b 4
;? Refresh
b 2
b 4
Enter o
telephone F

number here

7'.‘ Yeastar

(Figure 5-1)
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5.1.2 Call External Line Number

(1) Call external line numbers on contacts list: You can double click on the selected number, and
the system will call it with default routing. (If you don’t want to use the default routing, just select
the number and change the prefix on the input box below, system will save this new prefix and
apply it to this number when you call it out next time).

M NyPEX - 6041 =3
File View Contactz Teols Help
d v
B041 (Orline)
';,Call task * % Conference
O ! Missed calls
| Extenszions || Contacts || Histur}'” Volcemail ” Recurding|
(3444 Group X Delete Group
Hame Offiece Mabile
L & Toni DT02543 15253213512
Double ] : & Phili SBE4022 E1342522352
click it to Frieds ] @
ngr ouped &2 Tonylheng 7515551 1355902124
:_5 SinTom STOZ560 15552315954
"fj Kewin 52340635 15922535232
"-5 Jesseica 71552352 15952413652
;'5 catherine Z51B6E45 15580255416
.ﬂ Hnyony B465528 15426527524
".'j Een 15643663 15244565285
Number will be & Jue oA
shown on input & Teson B0t
box. ‘9" is the
prefix of default < 2
routing. t”
e
=+
(Figure 5-2)

(2) Call external line numbers that are not on contacts list: You can enter the number on the input
box and add the prefix to it, such as “9” for PSTN line routing, “81” for SIP routing; you can

enquiry Admin for other settings. System will auto call this number out from an idle trunk.

5.1.3 Call back a missed call

When you miss the incoming calls, just do as follows:
(1) Double click the number on History list and call out by default routing.
(2) Select the number on History list and add the prefix on input box to call out through

g
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designated routing.

5.2 Incoming Calls

You can execute the following operations for an incoming call:

e reject it

M EyPEX - 6041

File View Contacts Tools Help

5v

6041 (Online)

ICall task v @

Extensions ” Contacts ” Histor}'” ¥olcemail ” Recording” Call |

k‘:” 6013

Job Title:
Company:
Heb:

I| t“ Click here to

reject the call

@

oq

(Figure 5-3)

5.3 Call Forward

Do you always encounter the following situations in office?

1. Answered a call only to find that you are not wanted on the phone but your colleague.
2. You are on a call, and there’s another incoming call that you don’t want to miss.

3. You are busy doing things and have no time to answer calls.

4. You have to go out, but don’t want to miss any calls.

Don’t worry. MyPBX Client will help you deal with these.
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5.3.1 Forward before a call

When you go out or are too busy to answer a call, you can forward incoming calls to your mobile
or other number. Please see details on 4.11 Call Forwarding.

5.3.2 Transfer during a call

Step 1: Click the “Transfer call” button as Figure 5-4 shows

M EyPEE — fiD41

File V¥iew Contacts Tweols Help

dv

BO41 [Online)

Call task v 82

Exten=zions || Contacts || ]'[istu:-r}'” Volcema1l || Rec-:-rding” Call |

.

[ S

Job Title:
Comp angy
Web:

6013

Click this

button to
r\
FILPO

0o:0o:01

(Figure 5-4)

o -

Step 2: Select the number that you want to forward to on the pop-up screen (Figure 5-5). Click to
select a number, double click to forward call directly to this number. You can forward a call to an
extension, a contact, a ring group/IVR, or a telephone number entered on the input box. (You
need to add a prefix for forwarding to an external line number.)
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Transfer the

J Eﬂm” Cnrrtac:ts|

Click to select number or double click to transfer
S

Search extension...
 Name  Edno | Mobile Home *
- 3 Jason 6020
- @ Hamy 5021
- .J;? Catherine 6022 =
O Myoen 5023
8 ey 6024
o ) Jane 5025 R
. .@ Arthur 6027
- .@ Prince 6028
3 @ Rela 6025
E .@ 6040 6040 Al
N il 3
Qr input the number
6026
[ Transfer] [ Cancel ]
(Figure 5-5)

Step 3: Hang up the call to finish transferring or click “Flash” button to intercept a transferred

call.
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M x7ep3 — g0 B
File WView Contactz Tools Help
& -
B041 Mrline)
Call task v 8
Extenzions ” Contacts ” ]'[ist-:nr}'” Volcemall ” Recnrding” Call |
o
Gh
Y 6013
Job Title:
Compargy:
Web:
Hang up to
&Fﬂ "y G 0 1finish
0o o0 20
d]
L O
45 8
LRI
= 0 #* |
(Figure 5-6)

5.4 Call Parking

When you are on a call, you can park the current call on the Client instead of dialing feature code.
In this case, you can click the “Call Parking” button and then MyPBX will give you a parking
number. Dial this parking number on any extension to continue this call.
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(Figure 5-7)

5.5 Pick up a Call

5.5.1 Pick up a call from appointed extension

When your colleague is absent, his phone keeps ringing, you can pick up this call through the
following way:
On extension list, choose the ringing or on hold extension, right click and click “Pick up Call” on

the pop-up screen as Figure 5-8 shows.
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(Figure 5-8)

5.6 Call Task

Call Task can help you to call out a number on scheduled time or remind you to make a call to a
preset number.

(1) You can conduct the corresponding operation through the drop-down screen as Figure 5-9
shows.
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(Figure 5-9)
Make new call task: click here to pop-up a screen as Figure 5-11 shows
Show all call tasks: click here to open the task list as Figure 5-10 shows
Clear all call task: click here to delete all pre-arranged tasks
Refresh call task: click here to refresh the tasks list
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(Figure 5-10)

New: Click here to create a new task as Figure 5-13 shows
Edit: Click here to edit the chosen task item
Delete: Click here to remove the selected task item
(2) Input the telephone number, call time, etc on window Figure 5-13.

@ call task [x]
= Select a

The number you | time or
want to call — .

Date: |Ever}rda}r \/" I=l|| period to
At what time you | = [ Time: |IZI9 v| : |55 v| — | Name of this
want to call

Mema: |Task1 | call task

Oauto-dial |

| | ]

® Only remind

l

(Figure 5-11)

Enable this function,
the
the system

when time

0K Cancel

arrives,

will only remind you

(3) Click “OK” to finish creating or editing task. You will see the latest task on
interface as Figure 5-12 shows.
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(Figure 5-12)

5.7 Call Conference

MyPBX provides the call conference for users. You can invite max.30 users to join the conference

by MyPBX Client.
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Step 1: Click “Call Conference” button to have the pop-up a screen as Figure 5-14 shows so as to

invite people to join a conference.
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(Figure 5-14)
Step 3: You are allowed to select people in the extension list to join this conference.

Step 4: Click “OK” to see the conference call interface as Figure 5-15 shows.
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5.8 Internal Instant Message

MyPBX Client provides the internal instant message feature for users to chat easily with members

on the extensions list.

Step 1: On extensions list, select the member you want to chat with, right click to open the chat

screen.
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Step 2: Chat with selected extension user as Figure 5-17 shows.
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(Figure 5-17)

5.9 Voicemail

5.9.1 Leave a voicemail

Set “Forward to Voicemail”: Please check 4.11 Call Forwarding

5.9.2 Play a voicemail

When someone leaves a voice message on your voicemail, you can listen to the message directly.
Please check 4.4 Voicemail Management.
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Step 1: Select a voicemail and click “Play” button or double click the selected item to listen
toit.
Step 2: You can click “Stop” button or hang up the phone to stop the play.

5.10 Recording

5.10.1 Record Conversation

MyPBX Client provides recording function for users to record conversation.
During a call, you can click “Recording” button as Figure 5-19 shows; the system will start the
recording this conversation. Click “Stop” button when over; the system will auto finish the

recording when you hang up the call.
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5.10.2 Play Recording

All recordings will be stored on “Recording” listing, please refer to 4.5 Recording Management.
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(1) Select the item that you want to play, click “Play” button or double click on selected
item.
(2) You can click “Stop” button or hang up the phone to stop the play.

5.11 SMS

Right click the mouse and click “Send SMS” as Figure 5-21 shows, it will pop-up a window for
sending text as Figure 5-22 shows.
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Country Code | China +86

(Figure 5-22)

Note: Before sending a SMS, please confirm that the correct configuration of SMS setting is made

on MyPBX to make Email to SMS work. Choose one GSM trunk and the corresponding country
code on the SMS window first, and send the SMS.

6 Uninstall MyPBX Client

Uninstalling MyPBX Client will delete all your data, including contacts number, call log and

recorded voicemail on this PC. Before you uninstall MyPBX Client, make sure you have backed up
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the data you need.

Method 1:
1. Gotothe Window’s Start menu and open MyPBX Client Uninstall

2. The next prompt screen will guide you to close the current running program first.

Choose “Next” to continue the uninstallation program.

%¥ Dninstalling NyPBX Client

Welcome to the MyPBX Client

Uninstallation!
:;}’ ) This uninstall process will rermove MyPBRX Client from your
R, computer,
gy

Click Cancel if vou do not want to remove this application,

Clicl: Mext to continue the uninstall process.,

T [ Cancel

(Figure 6-1)

3. The Uninstallation progress will delete the MyPBX Client files from your computer. When the
uninstallation is complete, the Uninstall Finished screen will pop up. Click Finish button.
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% Dninstalling NyPBX Client

MyPBX Client has been
successfully uninstalled!

Click 'Finish' to complete the uninstallation,

(Figure 6-2)

Method 2:

1. Go tothe Windows Start menu and open the Control Panel.

2. Go to the Add or Remove Programs, which will open a new screen with a list of software
programs installed on the computer. Scroll down to MyPBX Client and click Change/Remove
button.

[Finish]
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